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Einleitung: 
 
Das Gebiet der Ennstaler Alpen gehört zu den Nördlichen Kalkhochalpen, die einige der 

eindrucksvollsten Berglandschaften Österreichs formen. Im Westen schließen sie mit den 

Haller Mauern (Gr. Pyhrgas, 2244 m) an das Warscheneck an. Im Osten gliedern sie sich in 

die Gebirgsstöcke der Gesäuseberge (Gr. Buchstein 2224 m, Hochtor 2369 m) und werden 

durch Enns und Erzbach von der Hochschwabgruppe und den Eisenerzer Alpen getrennt. Die 

südlich angrenzenden Eisenerzer Alpen werden bereits zu den Schieferalpen 

(Grauwackenzone) gerechnet. Auch an dieser Zone hat der Nationalpark einen kleinen Anteil. 

 

Die häufigsten Gesteinsformen sind der Dachsteinkalk und der Ramsaudolomit. Die 

Gesäuseberge bestehen aus Gebirgsketten (z.B. Hochtorgruppe) mit schroffen, steilen und 

meist unbewaldeten Felswänden und Gebirgsstöcken mit Hochflächen (z.B. Großer 

Buchstein). Die beiden Bergmassive sind vom Durchbruchstal der Enns, dem namengebenden 

"Gesäuse", voneinander getrennt. Die geologische junge Wildwasserschlucht ist gegenüber 

den Gipfeln über 1800 Meter tief eingeschnitten. 

 

Der Nationalpark Gesäuse wird geprägt von seinem geologischen und geomorphologischen 

Aufbau. Vor allem die extreme Reliefenergie ist bezeichnend. Auf engstem Raum steigen wir 

hier von Auwäldern an der Enns bis zu Fels- und Schuttfluren in den Kalkwänden hoch. Den 

umgekehrten Weg gehen Gesteins- und Schneelawinen. Die Häufigkeit dieser wird noch 

verstärkt durch hohe Schneemengen im Winter und häufige Starkregenereignisse im Sommer. 

 

Der Nationalpark Gesäuse bietet sich also als Untersuchungsgebiet für Extremereignisse in 

den Bereichen „Wildbach und Fluss“ aber auch „Sturm und Lawinen“ an. Er zeichnet sich 

durch das häufige Auftreten von hochdynamischen, natürlichen Vorgängen aus. Dies bewirkt 

eine hohe Artenvielfalt und diese zu erhalten ist eine der vordringlichsten Aufgaben der 

Nationalparkverwaltung. Gleichzeitig ist selbstverständlich auch der Schutz der Infrastruktur 

weiterhin zu gewähren. Dieses Spannungsfeld zwischen möglichst „freier Naturdynamik“ und 

„optimalem Schutz“ von Mensch und Infrastruktur macht die Besonderheit des 

Naturraummanagements im Nationalpark Gesäuse aus. 

 

Die folgenden Seiten sollen einen ersten, kurzen Überblick über relevante abiotische und 

biotische Faktoren im Nationalpark bieten.  
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1 Abiotische Umweltfaktoren 
 
Die Berechnung folgender abiotischer Habitatparameter erfolgte im GIS unter Anwendung des 

Spatial Analyst und auf der Datengrundlage des Digitalen Geländemodells (DGM). Die 

Zellgröße der Analysen richtet sich nach dessen Genauigkeit. Eine Ausnahme bildet die 

Erstellung des Parameters „Profil“, die mit Hilfe des 3-D-Analyst durchgeführt wurde. 

 Aktivieren des Spatial Analyst und 3D-Analyst: 

 Tools > Extensions > Spatial Analyst und 3D-Analyst anklicken 

Profil  

Mit der Funktion Interpolate Line wurde die Profilschnittlinie im DGM so festgelegt, dass sich 

daraus eine aussagekräftige Charakteristik des Untersuchungsgebiets ergibt (vgl. Abb.1 und 

Abb.2).  

 

 

Erstellen des Profilschnittes im GIS: 

 3D-Analyst > Button „Interpolate Line“ anklicken > Linie ziehen, die der Profilschnittlinie entsprechen 

soll >Button „Create Profil Graph“ anklicken > Profil wird erstellt 

 Änderungen der Profileigenschaften bzw. des Layouts: Mit re Maustaste auf Profil Graph Title (blauer 

Balken über Profil) > Properties > Advanced Options 

 

 

Gstatterboden

Enns

Profilschnittlinie
Grenze Planungsgebiet

±

 
Abb. 1: Profilschnitt 
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Höhenverteilung 

Die digitale Geländeoberfläche wurde mit der Funktion Reclassify in Höhenklassen ả 100 m 

eingeteilt. Es erfolgt zudem eine Klassifikation in die Höhenstufen „submontan“ (400 m – 800 m 

ü.NN), „montan“ (801 m – 1.400 m ü. A), „subalpin“ (1.401 m – 1.800 m ü. A) und „alpin“ 

(1.801 m – 2.800 m ü. A) (vgl. ADLER et.al. 1994). 

Erstellen der Höhenklassifikation im GIS: 

 DGM laden 

 Spatial Analyst >Reclassify > Inputraster: DGM > Classify > unter „Classification“ 20 Klassen festlegen 

> unter „Break Values“ Höhenklassenzahlen eingeben (500, 600, 700…..) > ok > unter „Outputraster“ 

Bezeichnung festlegen und abspeichern 

 Darstellungsänderung der Berechnung: mit re Maustaste auf Layer > Properties (Namensänderung unter 

“General“, Farbänderung unter „Symbology“) 

 

 

 

Expositionsverteilung 

Die Exposition wurde in 8 Klassen unterteilt (siehe Tab.1), wobei jeder Rasterzelle ein 

entsprechender Wert zugeordnet wurde. Bei einer Neigung von 0° (Flaches Gelände) konnte 

keine Hangausrichtung definiert werden; alle geneigten Flächen erhielten jedoch eine  

Zuweisung. Ihre Werte entsprechen der Richtung der Flächennormale in Grad, bezogen auf die 

Nordrichtung, welche mit 0° definiert ist.  

Erstellen der Expositionsklassifikation im GIS: 

 DGM laden 

 Spatial Analyst > Surface Analysis > Aspect (Input surface: DGM, Cellsize: 10, Outputraster: Bezeichnung 

festlegen) > ok  

 Spatial Analyst > Reclassify > Inputraster: berechnete Exposition; „New Values“ neu definieren („Old 

Values“ 0 – 22,5 und 337,5 – 360 müssen gleiche „New Values“, d.h. die gleiche Zahl, besitzen, da sie 

beide der Exposition Nord entsprechen) > unter Outputraster Bezeichnung festlegen 

 Darstellungsänderung der Berechnung: mit re Maustaste auf Layer > Properties (Namensänderung unter 

“General“, Farbänderung unter „Symbology“) 
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Tab. 1: Einteilung der Expositionsklassen 

 

Neigungsverteilung 

Die Hangneigung wurde in Grad angegeben und in 9 Klassen ả 10° eingeteilt. Hänge mit einer 

Neigung zwischen 0° - 10° wurden dabei als schwach, zwischen 10° - 50 ° als mittel und 

zwischen 50° - 90° als stark geneigt bezeichnet (vgl. LOUIS & FISCHER 1979). 

Erstellen der Neigungsklassifikation im GIS: 

 DGM laden  

 Spatial Analyst > Surface Analysis > Slope (Input surface: DGM, Outputmeasurement: Degree, Z factor: 

1, Cellsize: 10, Outputraster: Bezeichnung festlegen) > ok  

 Spatial Analyst > Reclassify  > Inputraster: berechnete Neigung > Classify > unter „Classification“ 9 

Klassen festlegen > unter „Break Values“ Neigungsstufen eingeben (10, 20, 30…..) > ok > unter 

„Outputraster“ Bezeichnung festlegen und abspeichern 

 Darstellungsänderung der Berechnung: mit re Maustaste auf Layer > Properties (Namensänderung unter 

“General“, Farbänderung unter „Symbology“) 

 

Einstrahlsituation  

Die Berechnung der Einstrahlsituation setzte die Azimuthwerte der einfallenden Sonnenstrahlen 

und die Sonnenstandhöhe bei entsprechender Uhrzeit voraus. Diese stammen aus einer 

Sonnenpositionsberechnung für das Jahr 2004 (QUASCHNING 2003, http://www.volker-

quaschning.de/datserv/sunpos/index.html). Da die Werte jahres- und uhrzeitabhängig sind, 

ergaben sich unterschiedliche Sonnenverhältnisse. Um interessante Aussagen zu erlangen, wurde 

die Besonnung für den 21. Dezember, den kürzesten Tag mit dem niedrigsten Sonnenstand, und 

den 21. Juni, den längsten Tag mit dem höchsten Sonnenstand, berechnet. Dies erfolgte zu 

beiden Jahreszeiten um 8 Uhr, 12 Uhr und 16 Uhr, im Sommer zusätzlich um 20 Uhr. Für die 

Exposition Azimut in Grad

Nord   0,01° - 22,5° / 337,5° - 360°

Nordost   22,5°  -    67,5°

Ost   67,5°  -  112,5°

Südost 112,5°  -  157,5°

Südost 157,5°  -  202,5°

Südwest 202,5°  -  247,5°

West 247,5°  -  292,5°

Nordwest 292,5°  -  337,5°
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Wintermonate wurde dabei die Mitteleuropäische Zeit (MEZ) und für die Sommermonate die 

Mitteleuropäische Sommerzeit (MESZ) angewandt. Bei den Berechnungen sind alle außerhalb 

der Untersuchungsgebiete liegende Reliefeinflüsse miteinbezogen worden. Himmelsstrahlung 

oder Bewölkung wurden nicht berücksichtigt.  

Berechnen der Einstrahlsituation im GIS: 

 DGM laden  

 Spatial Analyst > Surface Analysis > Hillshade (Input surface: DGM, Azimuth: je nach Jahres- und 

Uhrzeit, nachzusehen in A 1, Altitude: je nach Jahres- und Uhrzeit, nachzusehen in A 1, Model shadows 

aktivieren, Z factor: 1, Cellsize: 10, Outputraster: Bezeichnung festlegen) > ok  

 Spatial Analyst > Reclassify  > Inputraster: berechnetes Hillshade > Classify > unter „Classification“ 2 

Klassen festlegen > unter „Break Values“ Wert 1 und jeweils max Wert eingeben > ok > „New Values“ 

neu definieren: „Old Value“ 1 wird gleich 0 gesetzt und der „Old value“ max. Wert wird gleich 1 gesetzt 

(0=Schatten, 1= Sonne) > unter „Outputraster“ Bezeichnung festlegen und abspeichern 

 Darstellungsänderung der Berechnung: mit re Maustaste auf Layer > Properties (Namensänderung unter 

“General“, Farbänderung unter „Symbology“) 

2 Biotische Umweltfaktoren 
 
Zur Vegetation und zu den Lebensräumen im Nationalpark liegen verschiedene Datengrundlagen 

auf. Im Folgenden werden die einzelnen Untersuchungen kurz angeführt.  

 

2.1.1 HABITALP – Luftbildinterpretation: 

Ausgangsbasis für die Luftbildkartierung ist der im Rahmen von HABITALP weiterentwickelte 

CIR (Color-Infrared)-Luftbildkartierschlüssel des deutschen Bundesamtes für Naturschutz, der 

innerhalb eines INTERREG II A Projektes 1999 auf die speziellen Gegebenheiten im deutschen 

und österreichischen Alpenraum angepasst wurde. Als Kartierungsgrundlage dienen analoge 

Stereo-Infrarot-Luftbilder und georeferenzierte, digitale Farborthofotos. Bildschirmmaßstab für 

Abgrenzung und Interpretation war 1:3.000. 

Kartiert wurde mit Version „HIK 2“ (Habitalp Interpretation Key) des Interpretationsschlüssels. 

Dieser Schlüssel ist eine Weiterentwicklung des Interpretationsschlüssels, wie er z.B. im 

Nationalpark Hohe Tauern angewendet wurde und eignet sich besonders für waldreiche Gebiete. 

 
Für das Nationalparkgebiet (Planungsgebietsfläche = 125 km²) wurden 7.381 Polygone 

ausgewiesen (siehe Anlage 1). 

Die durchschnittliche Flächengröße beträgt 1,69 ha. 
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Der dominierende Habitattyp ist 5800 (Fels), der 16,8 % des Nationalparks bedeckt. 9,92 % der 

Fläche wurden dem HT 4240 zugewiesen (montane, subalpine bis alpine Rasen und Weiden). 

7000 (Wald) ist die dominierende Hauptgruppe. Nicht weniger als 64,5 % der Fläche, das sind 

80,8 km² werden von den 47 verschiedenen Habitat-Kategorien des Waldes eingenommen. 

Dieser Wert beinhaltet auch Latschenfelder, die an sich schon knapp 15 % ausmachen.  Am 

häufigsten wurden Fichtenbestände interpretiert. Weitere wichtige Baum- bzw. Straucharten: 

Latsche, Lärche, Kiefer, Buche, Ahorn, entlang von Johnsbach und Enns auch Esche, Grauerle 

und andere Laubbaumarten. 

Die meisten Flächen, die kleinste durchschnittliche Flächengröße und der größte 

Strukturreichtum liegt im SO des Nationalparks zwischen Planspitze und Lugauer. Hier befindet 

sich auch der Großteil der Alm- und Feuchtflächen 

5 % der Anzahl der Flächen sind Gebäude oder Straßen. In der Flächenausdehnung nehmen sie 

nur einen geringen Anteil von weniger als 1 % ein. 23 Altschneefelder (-flecken) wurden 

abgegrenzt.  

Eine Vielzahl an Auswertemöglichkeiten steht nun offen. Als Beispiel sei nur die 

Langzeitbeobachtung der Altschneefelder genannt, die Aussagen zur Klimaentwicklung 

ermöglichen (HOFFERT, H. & ANFANG, C. 2006). 

 

2.1.2 Biotopkartierung 

Die Biotopkartierung erfolgt in den sensiblen Talbereichen entlang der Flüsse Enns und 

Johnsbach (Fließgewässerlebensräume) unter Einbeziehung der Zubringer (Schuttgesellschaften) 

und der angrenzenden Wälder. Zu dieser Auswahl kam es aufgrund des erhöhten 

Managementbedarfs in diesen Gebieten (Schuttentnahmen, Errichtung von neuer Infrastruktur, 

Schutzbauten und  Konzentration von Verkehr und Tourismus). 

Vor allem geht es auch um jene Seitengräben, die am meisten Geschiebe führen und im 

Geschiebehaushalt mit all seinen positiven und negativen Auswirkungen eine große Rolle 

spielen. Als Vergleichsflächen zu den durch Entnahmen massiv beeinträchtigten Gebieten 

werden kaum beeinflusste Gräben herangezogen (siehe Gebietseinteilung Anlage 2). 

 

Die Biotopkartierung erfolgte flächendeckend im Maßstab 1:2.000 ab einer Biotopmindestgröße 

von 100 m² bei einer Biotopmindestbreite von 5 m. Als Kartiereinheiten wurden die Biotope 

entsprechend der "Roten Liste der gefährdeten Biotoptypen Österreichs" (ESSL ET AL. 2002, 2004 

& TRAXLER et al. 2005) zugrunde gelegt. Die Aufnahmen wurden in einem Erhebungsbogen, 

angelehnt an die Biotopkartierung Salzburg (NOWOTNY & HINTERSTOISSER 1994) dokumentiert 
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und in einer MS Access-Datenbank verwaltet. Biotope, die einem gefährdeten Biotoptyp 

und/oder einem Lebensraumtyp nach der FFH-Richtlinie (FFH-LRT nach Richtlinie 

92/43/EWG) zugeordnet werden konnten, wurden zusätzlich mit einer Artenliste dokumentiert. 

Weiters wurden die Biotope digital auf Farb-Orthophotos abgegrenzt. 

Die Taxonomie richtet sich nach FISCHER ET AL. 2005, die Syntaxonomie nach MUZINA, 

GRABHERR & ELLMAUER 1993, GRABHERR & MUZINA 1993 bzw. MUZINA, GRABHERR & 

WALLNÖFER 1993, ergänzend WILLNER 2001. Zur Ansprache der FFH-Lebensräume wurde 

ELLMAUER 2005 herangezogen. 

 

Als Pilotprojekt erfolgte die Biotopkartierung im Talbereich des Johnsbaches. Hier zeigte sich 

einer relativ hoher Anteil an äußerst schutzwürdigen Lebensräumen (KAMMERER 2005). Viele 

davon sind abhängig von der Dynamik eines geschiebeführenden Wildbaches, wie zum Beispiel 

Schotterpionierfluren, oder auch Grauerlenauen. 

 

In den beiden Seitengräben des Johnsbachtales Langgries (Anlage 4) und Gseng (Anlage 3), zu 

welchen aktuelle flächendeckende Kartierungsergebnisse vollständig vorliegen (KAMMERER 

2006a, 2006b), wurden insgesamt 290 Biotope auf 1647 Einzelflächen nachgewiesen. Die hohe 

Einzelflächenanzahl ist durch das redundante Vegetationsmosaik auf Dolomitfelsen begründet. 

Durch vollständige  Auskartierung der Biotope über die Untersuchungsgebietsgrenzen hinweg, 

erhöhte sich die gesamte Kartierungsfläche von 330,32 ha auf 366,32 ha. Die Flächengrößen der 

Einzelbiotope reichen von 13 m² bis zu 57,8 ha. 

 

Die genannten Teiluntersuchungsgebiete erfahren ihre Prägung durch die außerordentliche 

Geschiebeführung der namensgebenden Gräben. Aufgrund der begünstigten Verwitterungseigen-

schaften des Magnesium-Karbonats (= Hauptanteil des Dolomit) kommt es zu enormen 

Erosionskubaturen. Speziell die Schmelzwässer im Frühjahr verursachen mit ihren 

Ausspülungseigenschaften den Abtransport des gelockerten Gesteinsmaterials in Richtung des 

Vorfluters, dem Johnsbach. Zusätzlich führen Starkregenereignisse im Sommerhalbjahr zu einer 

weiteren, wenngleich deutlich geringeren Geschiebeumlagerung.  

Daher können Langgries- und Gsenggraben als hochdynamische Systeme verstanden werden, in 

welchen, bedingt durch die regionale geologische Situation und das niederschlagsreiche Klima 

im Nordstau der Randalpen, ganz spezielle Standortsverhältnisse vorherrschen, die nur von einer 

hochspezialisierten Flora und Vegetation als Lebensraum genutzt werden können. 
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In beiden Gräben existieren alle Übergänge von vollkommen vegetationsfreien 

Regschuttstandorten über junge Ruhschutthalden mit Pioniervegetation, die meist von der Alpen-

Pestwurz, Petasites paradoxus, begründet werden. Die weitere Entwicklung erfolgt auf 

feinerdearmen Standorten häufig über Gebüsche mit Lavendel-Weide, Salix eleagnos, zu 

Schneeheide-Kiefernwäldern, Erico-Pineten, welche bisweilen von Latschengebüschen 

durchdrungen werden, teilweise auch direkt zu diesen Latschen-Gebüschen. Bei entsprechender 

Bodenreife können sich später auch Fichten in diesen Beständen behaupten und zu trockenen 

Fichtenwäldern überleiten. Auf feinerdereichen Standorten gewinnen meist Hochgrasfluren 

überhand und bleiben in dieser Form oft sehr lange bestehen, bevor anspruchsvollere Gehölze, 

wie Berg-Ahorn, die weitere Waldentwicklung einleiten. Als Schlussgesellschaften treten 

Karbonatschutt-Fichten-Tannen-Buchenwälder ab der mittelmontanen Höhenstufe auf, darunter 

auch reine Buchenwälder (Asperulo-Fageten). 

 

Abschließend werden in den Berichten die Auswirkungen der Schotterentnahme in den beiden 

Gräben aus vegetationsökologischer Sicht betrachtet und bewertet. Sie zeitigen vielfältige 

eindeutige Einflüsse und verändern neben ökologischen Parametern speziell das optische 

Erscheinungsbild der Gräben massiv. Die auffälligsten dadurch bedingten Veränderungen sind 

im Bereich des Johnsbaches und dessen Strukturverarmung zu finden. 

 

2.1.3 Detail-Untersuchungsflächen in Lawinaren 

 

Im Jahr 2006 wurde mit der Erhebung der Biodiversität in Lawinenrinnen gestartet (siehe Anlage 

5). Dabei wurden von Dr. Andreas Bohner (HBLFA Raumberg-Gumpenstein, Abteilung für 

Umweltökologie) erste Vegetationsaufnahmen und von einem weiteren Expertenteam 

zoologische Untersuchungen vorgenommen (FRIEß ET AL. 2006).  

 

2.1.4 Biotoptypenverteilung 

 

Da die Luftbildklassifikation zu differenziert ist, erfolgte eine neue, zusammenfassende 

Einteilung in 10 Klassen. Diese ist in nachstehender Tabelle (vgl. Tab.2) aufgeführt:  
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Tab. 2: Einteilung der Biotoptypen 

1 Nadelwald dicht
2 Nadelwald licht
3 Mischwald
4 Laubwald
5 Latschen

6
Alp.Rasen / Magerr. /Wiesen / 
Hochst. / Sauerböden

7 Fels / Steinschutt / Kies

8 Moor

9 Versiegelte Flächen
10 Nicht definiert  

 

Erstellen der Biotoptypenklassifikation im GIS:  

 Luftbildklassifikation („Naturraum_fertig_plg“) laden >mit re Maustaste auf Properties > über 

„Join&Relates“  mit „Hauptabelle_19_5_03“ verbinden (über das Feld „Flächennummer“);  unter 

„VegetationsgesellschaftenNat.Inv“ steht der dazugehörige Erhebungsschlüssel 

 Luftbildklassifikation liegt als shape-file vor, muss für die weiteren Berechnungen in ein Rasterformat 

umgewandelt werden: Spatial Analyst > Convert > Features to Raster 

(Inputraster:„Naturraum_fertig_plg“; Field: Vegges_gro; Outputraster: Bezeichnung festlegen;  Cellsize: 

10) > ok 

 Reklassifizierung: Spatial Analyst > Reclassify > Inputraster: Biotoptypen;  bei den „New Values“ werden 

den Biotoptypen jeweils die in Tab.2 ersichtlichen Werte zugeordnet 

 Darstellungsänderung der Berechnung: mit re Maustaste auf Layer > Properties (Namensänderung unter 

“General“, Farbänderung unter „Symbology“) 

 

2.1.5 Potentielle Lawinengänge 

Hänge mit einer Neigung zwischen 30° - 50° werden als besonders lawinengefährdet angesehen. 

Ist der Winkel kleiner 30° bleibt der Schnee liegen. Bei über 50° ist das Gelände zu steil, als dass 

sich dort über längere Zeit große Schneemengen ansammeln können. Zudem entstehen Lawinen 

bevorzugt auf Flächen, die den Biotoptypen „Alpiner Rasen“ oder „Fels“ zugeordnet werden. 

Auf Grund der spärlichen Vegetation erfährt der Schnee dort keine Stabilisation und gerät 

schnell ins rutschen, ohne aufgehalten zu werden. Um eine grobe Verteilung der potentiellen 

Lawinenareale zu erhalten, sind Flächen mit diesen Eigenschaften aussagekräftig. 

Berechnen der Potentiellen Lawinenhänge im GIS: 

 Neigung und Biotoptypen laden 
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 Spatial Analyst > Raster Calculator > als Layer „Neigung“ wählen > Neigung zwischen 30° und 50° 

berechnen (Neigung>30 and Neigung<60) 

 Spatial Analyst > Raster Calculator > als Layer „Biotoptypen“ wählen > Biotoptypen „Fels“ und 

„Alp.Rasen“ berechnen (Biotoptyp=6 and Biotoptyp=7) 

 diese zwei Berechnungen nun miteinander verschneiden: Spatial Analyst > Raster Calculator > 

Neigung*Biotoptypen > Evaluate 

 Darstellungsänderung der Berechnung: mit re Maustaste auf Layer > Properties (Namensänderung unter 

“General“, Farbänderung unter „Symbology“)  
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3  Auswertung der abiotischen Umweltfaktoren im 
Untersuchungsgebiet  
3.1.1    Profil  

Für die Auswertung dieses Parameters wurde die Alpenvereinskarte des Untersuchungsgebietes 

hinzugezogen (ÖSTERREICHISCHER ALPENVEREIN 2002). Der Profilschnitt ist in Abb.2 ersichtlich. 

 

 
Abb. 2: Profil des Untersuchungsgebietes (NW – SE) 

 

Das charakteristische Landschaftsbild des Planungegebietes ist durch die tief eingeschnittenen, 

V-förmigen Täler der Enns (Ø 555 m ü. A) und des Johnsbachs (Ø 660 m ü. A) gegliedert. Diese 

teilen das Untersuchungsgebiet in drei Gebirgsmassive: Das Buchsteinmassiv (max.  

2.224 m ü. A) nördlich der von West nach Ost verlaufenden Enns sowie die südlich der Enns 

liegende Admonter Reichenstein- (max. 2.251 m ü. A) und die Hochtorgruppe (max.  

2.370 m ü. A), die wiederum durch das Johnsbachtal voneinander getrennt werden. Der 

Gebirgsstock des Admonter Reichensteins liegt dabei westlich und das Hochtormassiv östlich 

des von Süd nach Nord verlaufenden Johnsbachs.   

Da das Planungsgebiet des Nationalparks Gesäuse hauptsächlich durch die Buchstein- und die 

Hochtorgruppe sowie das dazwischen liegende Ennstal geprägt ist, werden die typischen 

Eigenschaften des Untersuchungsgebietes durch den von Nordwest nach Südost gelegten 

Profilschnitt (siehe Abb.2) erfasst.  

Der maximale Höhenunterschied ist zwischen den Ufern der Enns (etwa 500 m ü. A) und dem 

Hochtor (2.370 m ü. A) zu finden und beträgt 1.870 m. Auf Grund dieser orographischen 

Gegebenheiten ist im Planungsgebiet eine stark gekammerte Landschaft vorhanden.  

 

3.1.2    Höhenverteilung 

Das Planungsgebiet des Nationalparks Gesäuse erstreckt sich von etwa 500 m ü. A bis auf  

2.370 m ü. A. Nach der Höhenklassifizierung der vorliegenden Arbeit nimmt die hochalpine 
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Landschaft somit 20 Klassen ein. Ein deutlicher Schwerpunkt der Höhenverteilung liegt in den 

mittleren Lagen zwischen 601 m - 1.800 m ü. A (siehe A 2). Die in diesem Bereich liegenden 

Höhenklassen besitzen jeweils eine Flächenausdehnung von ungefähr 6 % - 8,5 % des 

Planungsgebietes. Die 1.500 m - Höhenklasse hebt sich dabei mit 8,61 % Flächenanteil als 

absolutes Maximum hervor. Es lässt sich ableiten, dass das Untersuchungsgebiet zu über 43 % 

durch die montane und zu über 30 % durch die subalpine Höhenstufe geprägt ist (siehe Abb.3). 

Der unter 800 m ü. A liegende submontane Bereich nimmt ein Areal von 15,95 % ein. Mit 

zunehmender Höhe erfolgt dort ein Anstieg der Flächenanteile der einzelnen Klassen. 

Entgegengesetzt dazu verhalten sich die Flächenausdehnungen der Höhenklassen des alpinen 

Bereichs. Hier nimmt der Anteil mit der Höhe kontinuierlich ab. Im Gesamten macht diese Stufe 

10,34 % des Gebietes aus.  



 

 
 Abb. 3: Höhenstufenverteilung im Untersuchungsgebiet   
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3.1.3    Expositionsverteilung 

Wie anhand der Abb.4 deutlich wird, liegt der flächenmäßige Anteil der einzelnen Expositionen 

im Planungsgebiet des Nationalparks Gesäuse weitgehend zwischen 10 % und 16 %. Eine 

gravierende Ausprägung der dortigen Landschaft ist somit nicht gegeben. Es lässt sich jedoch 

erkennen, dass die Expositionen Süd und Südost mit jeweils über 15 % Flächenanteil sowie die 

Ausrichtungen Nord und Nordwest mit knappen 14 % der Gebietsausdehnung etwas stärker 

vertreten sind. Eine leichte Ausrichtung der Gebirgsstöcke von West/Südwest nach Nordost/Ost 

ist deshalb erkennbar. Die Flachbereiche ohne Expositionszuweisung sind mit 0,01 % nur sehr 

gering. 

 

Bei Betrachtung der räumlichen Verteilung der Expositionen fällt deutlich die naturräumliche 

Unterteilung des Untersuchungsgebietes auf Grund des durchlaufenden Ennstals auf (siehe 

Abb.4). Das nördlich der Enns und nur teilweise im Planungsgebiet liegende Buchsteinmassiv 

definiert sich hauptsächlich durch südliche und östliche Expositionen. Die ebenso nur 

abschnittsweise im Untersuchungsgebiet liegende Admonter Reichensteingruppe ist v.a. durch 

östliche Expositionen auszumachen. Dagegen weist die, sich fast vollständig im 

Untersuchungsgebiet befindende, Hochtorgruppe alle Expositionen auf. Auf der nach Osten 

ausgerichteten Seite dieses Gebirgsmassivs sind kleinere Geländekammern erkennbar.  



  

   
Abb. 4: Expositionsverteilung im Untersuchungsgebiet 

Expositionsverteilung im 
Planungsgebiet des Nationalparks Gesäuse

Nationalpark Gesäuse GmbH
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3.1.4   Neigungsverteilung 

Wie in der Abb.5 deutlicht wird, ist das Planungsgebiet des Nationalparks Gesäuse zu 78,08 % 

durch eine mittlere Neigung geprägt. Die Neigungsstufe zwischen 30° - 40° ist mit 34,72 % 

Flächenanteil dabei am stärksten vertreten (siehe A 4). Das restliche Gelände dieses hochalpinen 

Untersuchungsgebietes setzt sich zu 16,92 % aus stark geneigten und nur zu 5 % aus flachen 

bzw. ebenen Bereichen zusammen. Daran lässt sich deutlich der hochalpine Charakter des 

Geländes erkennen, mit verhältnismäßig vielen, schroffen Geländebereichen. 

 

 

 

 



  

 
Abb. 5: Neigungsverteilung im Untersuchungsgebiet    
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Datum: 20.10.2006
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3.1.5    Einstrahlsituation 

Sommer 

Morgens um 8 Uhr sind im Untersuchungsgebiet 64,56 % der Flächen besonnt (vgl. Abb.6) und 

der Schattenwurf der umliegenden Gebirgsstöcke ist eindeutig auszumachen. Gegen Mittag bis 

in den Nachmittag hinein liegt hingegen fast das gesamte Planungsgebiet in der Sonne. So 

werden um 12 Uhr etwas über 96 % und um 16 Uhr noch immer knappe 92 % der Flächen 

bestrahlt. Abends um 20 Uhr befinden sich dagegen nur noch 21,5 % der Geländeoberflächen in 

der Sonne. Zu dieser Zeit ist die große Reliefenergie und somit die Abschattwirkung der 

hochalpinen Landschaft erneut deutlich erkennbar. 

Winter 

Am 21.12.04 besitzt das Planungsgebiet des Nationalparks Gesäuse zum Zeitpunkt des 

Sonnenhöchststands lediglich einen Sonnenanteil von 44,86 %. Hauptsächlicher Grund hierfür 

ist die starke Abschattung durch das Gebirgsmassiv der Hochtorgruppe (siehe Abb.7). Morgens 

um 8 Uhr sowie nachmittags um 16 Uhr befindet sich das gesamte Untersuchungsgebiet fast 

vollständig im Schatten und es werden nur 6,45 % bzw. 7,81 % der Oberfläche mit Sonne 

beschienen.    
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Abb. 6: Einstrahlsituation im Untersuchungsgebiet am 21.6.04 

Einstrahlsituation im Planungsgebiet des
Nationalparks Gesäuse am 21.06.04 

Nationalpark Gesäuse GmbH
Datum: 20.10..2006
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 Abb. 7: Einstrahlsituation im Untersuchungsgebiet am 21.12.04  
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Anhang: 
 
In den folgenden Tabellen erfolgt nochmals eine Kurzdarstellung der abiotischen und 
biotischen Verhältnisse im Nationalpark Gesäuse. 
 
Die Berechnung der abiotischen Faktoren erfolgte in ArcGIS und wurde großteils im Rahmen 
einer Arbeit zur Lebensraumbewertung des Steinadlers durchgeführt (HÖLSCHER 2005). Die 
Dokumentation der Arbeitsschritte ist textlich im Sinne der besseren Nachvollziehbarkeit in 
kurzen Absätzen beigefügt (kursiv, graue Schrift). 
 
Es  ist festzuhalten, dass bereits zahlreiche weitere Arbeiten über den Naturraum im Gesäuse 
vorliegen. Insbesondere zu den Themen Biodiversität, Almwirtschaft, Waldgesellschaften, 
Waldgeschichte, Totholz, Hydrologie und aus zahlreichen weiteren Fachgebieten. Eine 
Bibliographie zu den Forschungsarbeiten findet sich auf der Homepage des Nationalparks: 
 
http://www.nationalpark.co.at/ 
 
Hier findet man auch eine Übersicht zu den unterschiedlichen Fachbereichen, 
Kurzzusammenfassungen der Arbeiten und die meisten Arbeiten sind auch digital abrufbar. 
 
Weiter Informationen erhalten sie unter: 
 
 
Mag. MSc Daniel Kreiner 
Fachbereich Naturschutz & Naturraum 
Nationalpark Gesäuse GmbH 
8913 Weng im Gesäuse 
 
Tel.: ++43(0)3613-21000-30 
E-Mail: daniel.kreiner@nationalpark.co.at 
 
 

 

 

 A 1: Sonnenstandhöhe und Azimuthwerte für das Untersuchungsgebiet 

Jahreszeit Uhrzeit Höhe Azimuth
8 Uhr 26,2 83,06
12 Uhr 62,83 145,93
16 Uhr 47,86 251,1
20 Uhr 8,4 295,78

8 Uhr 1,25 127,16
12 Uhr 19,26 179,7
16 Uhr 1,56 232,39
20 Uhr 0 0

Sommer

Winter

 
 
 
 
 



A 2: Höhenklassen im Untersuchungsgebiet 

in km2 in %

    0 - 500 0,10 0,08
501 - 600 4,42 3,54
601 - 700 7,66 6,13
701 - 800 7,76 6,21

801 - 900 8,27 6,62
  901 - 1.000 9,21 7,37
1.001 - 1.100 9,47 7,58
1.101 - 1.200 9,33 7,46
1.201 - 1.300 8,69 6,95
1.301 - 1.400 9,59 7,67
1.401 - 1.500 10,76 8,61
1.501 - 1.600 10,63 8,50
1.601 - 1.700 8,90 7,12
1.701 - 1.800 7,26 5,81
1.801 - 1.900 4,90 3,92
1.901 - 2.000 3,67 2,94
2.001 - 2.100 2,70 2,16
2.101 - 2.200 1,26 1,01
2.201 - 2.300 0,34 0,28
2.301 - 2.400 0,04 0,03

Flächenanteil 
Höhenklassen in m ü. A

 
 
 
 
 

 

A 3: Expositionsklassen im Untersuchungsgebiet 

in km2 in %
Flach 0,01 0,01
Nord 17,22 13,78
Nordost 11,95 9,57
Ost 13,55 10,85
Südost 19,59 15,67
Süd 19,37 15,50
Südwest 14,09 11,27
West 12,21 9,77
Nordwest 16,99 13,60

Exposition
Flächenanteil 

 
 
 
 
 



A 4: Neigungsklassen im Untersuchungsgebiet 

in km2 in %
  0 - 10 6,25 5,00
10 - 20 14,09 11,28
20 - 30 24,95 19,96

30 - 40 34,72 27,78
40 - 50 23,82 19,06
50 - 60 13,10 10,48
60 - 70 6,22 4,98
70 - 80 1,76 1,40
80 - 90 0,07 0,06

Neigung in °Grad
Flächenanteil 

 
 
 

 
A 5: Einstrahlverhältnisse während der Sommermonate im Untersuchungsgebiet 

Uhrzeit Sonnenflächenanteil in % Schattenflächenanteil in %
8 Uhr 64,56 35,44

12 Uhr 96,54 3,46
16 Uhr 91,64 8,36

20 Uhr 21,50 78,50  
 

 

A 6: Einstrahlverhältnisse während der Sommermonate im Untersuchungsgebiet 

Uhrzeit Sonnenflächenanteil in % Schattenflächenanteil in %
8 Uhr 7,81 92,19

12 Uhr 44,86 55,13
16 Uhr 6,45 93,54  

 

 

 
A 7: Biotoptypenverteilung im Untersuchungsgebiet 

in km2 in %
Nadelwald dicht 32,22 25,78
Nadelwald licht 16,37 13,10
Mischwald 14,06 11,25
Laubwald 3,72 2,98
Latschen 24,95 19,96
Alp.Rasen / Magerr. /Wiesen / 
Hochst. / Sauerböden 9,79 7,84
Fels / Steinschutt / Kies 20,32 16,26
Moor 0,06 0,05
Versiegelte Flächen 0,31 0,24
Nicht definiert 3,18 2,54

Biotoptyp
Flächenanteil

 
 



Anlage 1: HABITALP-Luftbildinterpretation 

 
 



 

Anlage 2: Gebietseinteilung Biotopkartierung 
 



Anlage 3: Detailkarte FFH-Lebensräume Gseng 
 



Anlage 4: Detailkarte FFH-Lebensräume Langgries 
 



Anlage 5: Untersuchungsflächen  HBLFA Raumberg-Gumpenstein (A. Bohner) 


